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1 NHN USER GUIDE SERIES 

The National Hydro Network (NHN) is a geospatial vector data product that forms the hydrographic layer 
of the GeoBase ( www.geobase.ca ) for Canada. For more information about this product, please refer to 
the following link: http://www.geobase.ca/geobase/en/data/nhn/index.html  

The National Hydro Network User Guide Series has been created to help users get the most from NHN 
data very quickly. It is designed to rapidly provide NHN data users with GIS or software specific 
information to facilitate NHN data use and exploitation within a specific software environment. Whereas 
some specific GIS and software environments are targeted to achieve this goal, there is no intent to cover 
them all. The NHN User Guide Series is intended for the majority of NHN users. Therefore, it is oriented 
towards the most popular systems and software environments used by NHN data users. 

2 CONTEXT 

This document is about using NHN data in the ArcGIS environment (ESRITM – Environmental Systems 
Research Institute - http://esri.com/ ). It specifically aims at helping ArcGIS users to quickly create a 
Geometric Network from NHN data in ArcGIS 9.x. 

Exploiting an ArcGIS Geometric Network can easily be done through the Utility Network Analyst toolbar in 
ArcMap. This toolbar allows a user to perform different operations on an ArcGIS Geometric Network such 
as Trace Upstream/Downstream, Find Loops in Network, Find Path, etc. These functionalities allow users 
to perform many different queries on the network and prove to be very useful in cases such as tracing a 
contaminant path in a drainage network, identifying tributaries of a particular stream where fish or other 
species can migrate to, etc. At the present time, all those types of query can be performed in ArcMap with 
ArcView, ArcEditor or ArcInfo licenses from ESRI, whereas ArcGIS Geometric Network data creation, 
management and editing requires an ESRI ArcEditor or ArcInfo license. 

This document proposes one particular way of creating a Geometric Network from NHN data in ArcGIS 
9.x. It does not attempt in any way to explore, present or describe all possibilities or other ways of 
achieving similar results, nor does it attempt to explain or justify the choices made with the presented 
approach. It contains many excerpts from the ArcGIS Desktop Help, which are shown "in italic", the whole 
in order to be as simple and complete as possible and avoid numerous references to external 
documentation. 

3 ESRI GEODATABASE ITEMS 

Environmental Systems Research Institute's (ESRITM) geodatabases organize geographic data into a 
hierarchy of data objects. These data objects are stored in feature classes, object classes, and feature 
datasets. An object class is a table in the geodatabase that stores nonspatial data. A feature class is a 
collection of features with the same type of geometry and the same attributes. 

A feature dataset is a collection of feature classes that share the same spatial reference. Feature classes 
that store simple features can be organized either inside or outside a feature dataset. Simple feature 
classes that are outside a feature dataset are called standalone feature classes. Feature classes that 
store topological features must be contained within a feature dataset to ensure a common spatial 
reference. 

ArcGIS' ArcCatalog contains tools for creating object classes (tables), feature classes, and feature 
datasets. Once these items are created in the geodatabase, further items such as subtypes, simple 
relationship classes, composite relationship classes, geometric networks and topologies can also be 
created. 
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4 ABOUT GEOMETRIC NETWORKS 

A network is a system of interconnected elements, such as lines connecting points. Examples of networks 
include highways connecting to cities, streets interconnected to each other at street intersections, 
drainage network streams and watercourses interconnected to each other at their intersection, and sewer 
and water lines that connect to houses. Connectivity is inherently important in order to travel over the 
network. Network elements, such as edges (lines) and junctions (points), must be interconnected to allow 
navigation over the network. Additionally, these elements have properties that control navigation on the 
network. 

Geometric networks consist of edge network features and junction network features. An example of an 
edge feature is a water main, and a junction feature might be a valve. Edges must be connected to other 
edges through junctions. Edge features are related to edge elements in the network, and junction features 
are related to junction elements in the logical network.  

In GIS, networks are widely used for two kinds of modeling—transportation and utility network modeling. 

Transportation networks are undirected networks. This means that although an edge on a network may 
have a direction assigned to it, the agent (the person or resource being transported) is free to decide the 
direction, speed, and destination of traversal. For example, a person in a car traveling on a street can 
choose which street to turn onto, when to stop, and which direction to drive. Restrictions imposed on a 
network, such as one-way streets or "no U-turn allowed", are guidelines for the agent to follow. This is in 
stark contrast to the utility network. In ArcGIS, transportation networks are modeled using network 
datasets. 

A utility network is directed. This means the agent (for example, water, sewage, or electricity) flows along 
the network based upon certain rules built into the network. The path that the water will take is 
predetermined. It can be changed, but not by the agent. The engineer controlling the network can change 
the rules of the network by opening some valves and closing others to change the direction of the 
network. In ArcGIS, utility networks are modeled using geometric networks. 

The utility network model or geometric network is best suited for a drainage network such as the NHN. 

5 GEOMETRIC NETWORKS IN ARCGIS 

NOTE: Although geometric networks can be both created and edited in ArcInfo and ArcEditor, they are 
read-only in ArcView. 

In ArcGIS, networks are modeled as a one-dimensional nonplanar graph, or geometric network, that is 
composed of features. These features are constrained to exist within the network and can, therefore, be 
considered network features. ArcGIS automatically maintains the explicit topological relationships 
between network features in a geometric network. Network connectivity is based on geometric 
coincidence, hence the name geometric network. 

In ArcGIS, utility networks as well as drainage networks like the NHN are modeled using geometric 
networks. A geometric network is a connectivity relationship between a collection of feature classes in a 
feature dataset. Geometric networks are objects within the geodatabase. They can only be built in a 
Personal Geodatabase (PGD) or as part of an ArcSDE Geodatabase. 

A geometric network has a corresponding logical network. The geometric network is the actual set of 
feature classes that make up the network. The logical network is the physical representation of the 
network connectivity. Each element in the logical network is associated with a feature in the geometric 
network. Once a geometric network is in place, ArcMap and ArcCatalog have tools that treat the network 
features in a special way. Editing and tracing on the network, as well as managing the feature classes 
participating in the network, are all handled automatically by ArcGIS. 
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Geometric networks can be managed using ArcCatalog. Unlike most items that appear in ArcCatalog, the 
geometric network does not represent a single entity, such as a table, shapefile, or feature class. A 
geometric network is actually an association among several feature classes and is represented by several 
tables in the database. Managing a geometric network is different from managing other items in 
ArcCatalog. 

Two methods are available for creating a network: creating a new, empty geometric network or building a 
geometric network from existing simple features. This document proposes an approach to create a 
geometric network in a PGD using ArcGIS with NHN data in input. 

The process of building a geometric network from existing data can be summarized in the following steps, 
all performed in ArcCatalog:  

 Import data into new or existing feature classes. 

 Build a geometric network from the feature classes. 

 Add feature classes to the geometric network. 

 Establish connectivity rules for the geometric network. 

 

5.1 How Networks Are Built (ArcCatalog) 

Building networks from existing features is a computationally intense operation that may take a 
considerable amount of time and system resources, depending on the number of input features. If those 
features require snapping, the network building operation will spend most of its time in the feature 
snapping phase. 

In ArcCatalog, the network building process proceeds in the following sequence:  

1. If snapping is specified, snap simple features.  

2. If snapping is specified, snap complex features.  

3. Create an empty logical network.  

4. Create the network schema in the database.  

5. Extract attributes from the input feature classes for weight calculations.  

6. Create the topology.  

7. Create orphan junctions as required, add input junction features to the logical network, and 
initialize the junction-enabled values.  

8. Set weight values for the junction elements.  

9. Add edges to the logical network.  

10. Set weight values for the edge elements.  

11. Create all necessary indexes in the database.  
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6 HOW TO CREATE A GEOMETRIC NETWORK IN ARCGIS USING NHN DATA 

This document proposes an approach to create a geometric network in a Personal Geodatabase (PGD) 
using ArcGIS 9.x (English version) with NHN data in input. NHN features used to create an ArcGIS 
Geometric Network are the Network Linear Flow and Hydro Junction features. 

At the present time, querying a Geometric Network in ArcMap can be performed with ArcView, ArcEditor 
or ArcInfo licenses from ESRI, whereas ArcGIS Geometric Network data creation, management and 
editing requires an ESRI ArcEditor or ArcInfo license. 

6.1 Creating the Personal Geodatabase (PGD) in ArcCatalog 

An ArcGIS Geometric Network can only be built in a Personal Geodatabase (PGD) or as part of an 
ArcSDE Geodatabase. In ArcCatalog, the steps to create a PGD are described as follows: 

1. Click the folder or folder connection in which you want to create a new personal geodatabase. 
Make sure you create it in a location with sufficient disc space. 

2. Click the File menu.  

3. Point to New and click Personal Geodatabase.  

4. Type a new name for the personal geodatabase. Let's call it "Test.mdb" for the purpose of the 
exercise. 

5. Press Enter.  

6. Enter the "Test" personal geodatabase by double clicking on it. You will find the PGD empty when 
viewed in the contents window, since no data has been added to it. 

Or 

1. Navigate to an existing folder or create a new one to house the PGD. 

2. Click the Contents tab in ArcCatalog's right window. 

3. Right-click on the window space and select New -> Personal Geodatabase. 

4. Type a new name for the personal geodatabase. Let's call it "Test.mdb" for the purpose of the 
exercise. 

5. Press Enter. 

6. Enter the "Test" personal geodatabase by double clicking on it. You will find the PGD empty when 
viewed in the contents window, since no data has been added to it. 

6.2 Creating the Feature Dataset in ArcCatalog 

Feature datasets exist in the geodatabase to define a scope for a particular spatial reference. All feature 
classes that participate in topological relationships with one another (for example, a geometric network or 
topology) must have the same spatial reference. Feature datasets are a way to group feature classes with 
the same spatial reference so they can participate in topological relationships with each other.). 

Still in ArcCatalog: 

1. In the ArcCatalog tree, right-click the database in which you want to create a new feature dataset, 
namely the "Test.mdb" PGD created at the previous section. 
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2. Point to New.  

3. Click Feature Dataset.  

4. Type a name for the feature dataset. Let's call it "FeatureDataset1" for the purpose of the 
exercise. 

5. Click OK to save the feature dataset as is with an "Unknown Coordinate System" (see Figure 1). 
Its spatial reference can be defined now or later. The present exercise will deal with it later. 

 

Figure 1 

Something you should know about a feature dataset's spatial reference: 

When creating a new feature dataset or standalone feature class, you must specify its spatial reference. 
The spatial reference for a feature class describes its coordinate system (for example, geographic, UTM, 
or State Plane), its spatial domain, and its precision. The spatial domain is best described as the allowable 
coordinate range for x,y coordinates, m- (measure) values, and z- (elevation) values. The precision 
describes the number of system units per one unit of measure. A spatial reference with a precision of 1 
will store integer values and a precision of 1,000 will store three decimal places. Once the spatial 
reference for a feature dataset or standalone feature class has been set, only the coordinate system can 
be modified—the spatial domain is fixed.  

All feature classes in a feature dataset share the same spatial reference. The spatial reference is an 
important part of geodatabase design because its spatial domain describes the maximum spatial extent to 
which the data can grow. You must be careful to choose an appropriate x, y, m, and z domain. For 
example, if you create a feature dataset with a minimum z-value of 0 and a precision of 1,000, none of the 
features in the feature dataset can have z-values that are less than 0, and all z-values will be stored to 
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three decimal places. The same rule applies to x- and y-values. The exception to the rule is m domains; 
feature classes within the same feature dataset can have different m domains.  

The spatial domain for a feature class or feature dataset cannot be changed. If the required x-, y-, m-, or 
z-value ranges for your database change, the data has to be reloaded into feature classes with a spatial 
reference that accommodates the new value range. 

6.3 Setting the Feature Dataset Spatial Reference in ArcCatalog 

NOTE: For efficiency purposes, the steps covered in this section can easily be inserted between step 4 
and 5 of the previous section. 

When creating a feature dataset within a geodatabase to store your feature classes or standalone feature 
class, the most important setting is the spatial reference. The coverage, shapefile, and geodatabase 
feature class all handle geometry and coordinate precision differently. In the coverage data model, you 
can add new features outside the old extent, and the BND file will adjust itself accordingly. However, this 
is not the case in the geodatabase. Once a geodatabase feature dataset or feature class has its extent 
defined, it cannot be changed. Thus, when importing data into the geodatabase, care should be taken to 
ensure the destination feature class has its xy scale set comparable with the expected accuracy of the 
input data source. 

Now, the feature dataset just created has no spatial reference yet (Unknown Coordinate System), so we 
must create it or select it from an existing dataset. In the present exercise, the NHN Index in SHAPE 
format (NHN_INDEX_<version>_INDEX_WORKUNIT_LIMIT_2.shp) published on the GeoBase web 
portal under the NHN data section is used. This dataset has the same coordinate and reference system 
as all NHN datasets offered on GeoBase and covers the entire Canadian landmass, making it a good 
candidate for this operation. 

NOTE: If you are concerned about only one NHN dataset, you may disregard the previously mentioned 
NHN Index dataset and use your NHN dataset of interest instead. 

Still in ArcCatalog, let's now set the Feature Dataset spatial reference: 

1. In the ArcCatalog navigation tree, right-click the Feature Dataset created at previous section 
(FeatureDataset1). 

2. Select (click) Properties… The Feature Dataset Properties window shows up. 

3. In the Feature Dataset Properties window click the Edit… button. The Spatial Reference 
Properties window pops up. 

4. In the Spatial Reference Properties window click the Import… button and browse to the dataset to 
use as the spatial reference for the Feature Dataset (FeatureDataset1), namely the 
"NHN_INDEX_<version>_INDEX_WORKUNIT_LIMIT_2.shp" which in the present case 
corresponds to the NHN Index in SHAPE format. 

5. Click the Add button in this Browse for Dataset window. You now get the Spatial Reference 
Properties window with the Coordinate System defined (re.: Coordinate System tab). See Figure 
2. Selecting another tab (e.g. the X/Y Domain tab) will indicate the extent of the Feature Dataset. 
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Figure 2 

6. Click the OK button in this Spatial Reference Properties window. You now get the Feature Dataset 
Properties window with the Spatial Reference defined for the Feature Dataset (FeatureDataset1). 
See Figure 3. 

7. In this Feature Dataset Properties window click the OK button to save this Spatial Reference for 
the Feature Dataset (FeatureDataset1). 
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Figure 3 

INFO: General steps to define the Feature Dataset's spatial reference are: 

1. Referring to Figure 3, click Edit to define the feature dataset's spatial reference. 

2. Referring to Figure 2, click Select or Import to set the feature dataset's spatial reference. 

3. Navigate to the spatial reference you want to use, or navigate to the feature class or feature 
dataset whose spatial reference you want to use as a template. 

4. Referring to Figure 2, click Modify if you want to change any parameters in the coordinate system 
you've chosen. Edit the coordinate system's parameters, and click OK. 

5. Referring to Figure 2, click the X/Y Domain tab. 

6. Type the minimum x- and y- and maximum x- and y-coordinate values for the dataset, and type 
the required precision for the coordinate values. 

7. Referring to Figure 2, click the Z Domain tab. 

8. If any feature class in the feature dataset will have z-values, type the minimum z-value and 
maximum z-value for the dataset, then type the precision required for the z-coordinates. 

9. Referring to Figure 2, click the M Domain tab. 

10. If any feature class in the feature dataset will have measures, type the minimum m-value and 
maximum m-value for the dataset, then type the precision required for the m-values. 
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11. Referring to Figure 2, click OK. 

12. To see the details of your new dataset's spatial reference, check Show Details. (Figure 3). 

13. Referring to Figure 3, click OK. 

6.4 Adding NHN Data to the Feature Dataset in ArcCatalog 

The Feature Dataset "FeatureDataset1" has now a spatial reference and domain. The next logical step is 
adding NHN data to it, which data will later be used to create a Geometric Network. 

Still in ArcCatalog, let's add the NHN data required for the Geometric Network to the Feature Dataset: 

1. In the ArcCatalog tree, right-click the Feature Dataset created at the previous section 
(FeatureDataset1). 

2. Point or select (click) Import, and then select Feature Class (multiple)… (Figure 4), since 
more than one feature class is required especially when many NHN datasets are involved. 
The Feature Class to Geodatabase (multiple) window shows up (Figure 5). 

 

Figure 4 
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Figure 5 

3. In the Feature Class to Geodatabase (multiple) window (Figure 5), click the "Browse for file" 
Icon next to the Input Features text box. In the Input Features window that pops up, browse 
for the NHN Shape files that you want and select them (Figure 6). 

 

Figure 6 
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4. In order to create the ArcGIS Geometric Network later, the files to add at this time are the 
Shapefiles containing the Hydro Junction and Network Linear Flow NHN features. Select 
them for each NHN dataset involved ("Shift + click" for multiple selection). Once selected, 
click the Add button to add them to the Feature Class to Geodatabase (multiple) window.  

5. Repeat steps 3 and 4 as many times as there are other NHN datasets required to build the 
ArcGIS Geometric Network. 

6. Once the entire selection is completed, click the OK button in the Feature Class to 
Geodatabase (multiple) window to add these features to the Feature Dataset 
(FeatureDataset1) in the Geodatabase (Test.mdb). During this processing, a log information 
window that monitors the process pops up (Figure 7). 

 

Figure 7 

7. Once the processing is completed, read the processing info contained in the window to 
ensure everything is OK and then click the Close button to close this window (Figure 8). The 
NHN features are now added to the Feature Dataset (FeatureDataset1) in the Geodatabase 
(Test.mdb).  

 

Figure 8 
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8. Preview the data in ArcCatalog and examine the metadata for each dataset by selecting the 
Metadata tab to see if it makes sense. 

6.5 Creating the Geometric Network in ArcCatalog 

NOTE: Although geometric networks can be both created and edited in ArcInfo and ArcEditor, they are 
read-only in ArcView. 

An alternative to creating and populating an empty geometric network is to build a geometric network from 
existing simple feature classes. The Build Geometric Network wizard discovers the connectivity for a 
group of feature classes in a feature dataset and promotes them from simple feature types (lines and 
points) to network feature types (edges and junctions). When you build a geometric network, the feature 
classes must already exist in the feature dataset. However, they can be empty. After the network has 
been built, you can add new network feature classes. Geometric networks can be built using either 
ArcCatalog or ArcToolbox. At any time during the building process, you can abort by clicking Abort on the 
Progress dialog box. When you abort the build, the system deletes any network tables created and sets 
the database to the state before the build started. If snapping was already complete, that change is 
permanent and won't be restored. The geometric network builder can automatically adjust features in the 
input feature classes to correctly snap to connecting features. The default snapping tolerance is 1.5* 1/XY 
scale of the feature dataset's spatial reference. If snapping, you cannot use a value smaller than the 
default. Large snapping tolerances may cause unanticipated results. For best results, examine your data 
and provide a more appropriate tolerance. Snapping (geometry changes) cannot be undone. 

The Feature Dataset "FeatureDataset1" has now a spatial reference and NHN data added to it. This data 
can be used to create an ArcGIS Geometric Network. Still in ArcCatalog, let's now create the Geometric 
Network from the NHN data already in the Feature Dataset: 
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Figure 9 

1. In the ArcCatalog tree, right-click the Feature Dataset created at the previous section 
(FeatureDataset1) (Figure 9). This Feature Dataset will contain the Geometric Network. 

2. Point or select (click) New, and then select Geometric Network… (Figure 9). 

 

Figure 10 

3. In the Build Geometric Network Wizard window that pops-up, read the information on the panel 
and click the "Next >" button to initiate the Geometric Network creation process (Figure 10). 
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Figure 11 

4. In the Build Geometric Network Wizard second window, click the "Build a geometric network from 
existing features" radio button (first option) and then the "Next >" button to continue (Figure 11). 

 

Figure 12 

5. In the Build Geometric Network Wizard third window, click the "Select All" button or individually 
check mark all NLFLOW and HYDROJUNCT features in the window. You can modify the Network 
name in the bottom text box if desired. Then click the "Next >" button to continue (Figure 12). 
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Figure 13 

6. In the Build Geometric Network Wizard fourth window, click the "No" radio button to avoid creating 
complex edges in the network and then click the "Next >" button to continue (Figure 13). 

 

Figure 14 

7. In the Build Geometric Network Wizard fifth window, click the "No" radio button to avoid a 
snapping operation over the NHN features and then click the "Next >" button to continue (Figure 
14). Snapping generally results in feature geometry modifications so one should be aware of the 
possible consequences and very careful before using it. 

Note: NHN features having spatial relationships are normally geometrically coincident or 
"snapped" together. This is referred to as "clean" data. It means their start and end vertices 
exactly match those of adjoining features having a spatial relationship with in the case of linear 
and point features, or they share the exact same external boundary section in the case of 
polygonal features having a spatial relationship. Refer to the NHN Standard for more information 
on spatial relationships between NHN features. 

About snapping… 

Ideally, your data should be clean before you build a network. Clean data means that all features 
that should be connected in the network are geometrically coincident—that is, no overshoots or 
undershoots. However, if this is not the case, the data may be snapped during the network 
building process. It is important to understand how connectivity is established based on snapping 
during the network building process and how feature geometries are adjusted to establish that 
connectivity. 

When snapping features during network building, it is important to understand how the geometry 
of features is adjusted when snapping. All or part of any feature in a feature class that was 
specified as being adjustable in the Build Geometric Network wizard can potentially be moved. 
Those features in feature classes that are not adjustable will remain fixed throughout the network 
building process. All features in all feature classes have equal weights when being adjusted 
during snapping. This means that if the endpoints for two edges need to be snapped and both 
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features can be adjusted, then they will move an equal distance to snap together. If one of the 
features is not adjustable, then only the adjustable feature will move to snap to the static feature. 

 

Figure 15 

8. In the Build Geometric Network Wizard sixth window, click the "No" radio button since there are 
no sinks or sources in NHN features and then click the "Next >" button to continue (Figure 15). 

 

Figure 16 
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9. In the Build Geometric Network Wizard seventh window, click the "No" radio button to avoid 
assigning weights to the network. Then click the "Next >" button to continue (Figure 16). 

 

Figure 17 

 

Figure 18 

10. In the Build Geometric Network Wizard eighth window, review the summary of your input. It is 
possible go back to correct input errors ("< Back" button). When satisfied click the "Finish" button 
to launch processing to build the Geometric Network (Figure 17 and 18). 
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Figure 19 

11. In the Build Geometric Network processing window that pops up, the progression between the 
Build Geometric Network processing phases is shown. Abort processing at any time with the 
"Cancel" button. Refer to the first paragraph of the present section for the consequences of 
aborting processing. If not cancelled, processing should normally complete (Figure 19). 

 

Figure 20 

12. Once the Build Geometric Network processing is completed, an Invalid Features Report window 
pops up if some features could not be added to the network (Figure 20). Click the "OK" button to 
close this window. When such thing happens, first note the feature class(es) mentioned on the 
window panel. Then, in ArcMap, using the ObjectIDs found in the newly created 
"<geometricnetwork_name>_BUILDERR" table (FeatureDataset1_ Net_BUILDERR in this case) 
within the Geodatabase (Test.mdb in this case) (Figure 21), locate those errors to see what the 
problems are. Surprisingly, there is not always a problem. In the present case for instance, 
although two invalid features were reported, the Geometric Network had still been created using 
those features. Checking the invalid features reported here led to the conclusion that the Build 
Geometric Network process was sensitive to very short linear features (both "faulty" features 
measure less than one metre long in the present case). In spite of the Invalid Features Report, 
since the network had been created normally here, including both reported "faulty" features, no 
further actions were then required in this case. Click the "OK" button to close the Invalid Features 
Report window when finished (Figure 20). Refer to next section for more information on Geometric 
Network Buid Errors. At this point the Geometric Network exists and can be viewed in ArcCatalog 
(Figure 22). 
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Figure 21 

 

Figure 22 
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6.6 Network Build Errors 

NOTE: While geometric networks can be both created and edited in ArcInfo and ArcEditor, they are read-
only in ArcView. 

When building a geometric network from existing simple feature classes, illegal network geometries may 
be encountered in some of the input feature classes. Instead of failing when an illegal geometry is 
encountered, the network builder creates an instance of the feature as a network feature but will not 
create any network connectivity for that particular feature. If this occurs, a warning message is displayed 
at the end of the network building process (Figure 20), and a table is created in the database to record 
these errors (Figure 21). 

The warning message will report the total number of illegal features in each network feature class (Figure 
20). The error table's name will be <geometricnetwork_name>_BUILDERR (Figure 21). 

6.6.1 Network Build Errors Table 

 

Field name Error information 

ErrorID The ID of the error object 

ClassID The object class ID of the feature class containing the illegal geometry 

ObjectID The object ID of the feature with illegal geometry 

ErrorType The error for this feature 

 

Error Code Error description 

10 The feature has an empty geometry 

11 The feature's geometry has multiple parts 

12 The feature's begin and end vertex are the same 

13 The feature has a geometry with a zero length 
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ArcMap has tools that allow you to use the network build error table to identify these illegal features. Once 
you have identified the features and repaired their geometries to be legal geometries, you can use the 
Rebuild Connectivity tool to repair the network connectivity for those features. 

The Network Build Error Table will only show those features that have illegal network geometry at the time 
the network was built. If you repair these features, or other features are created in the network with illegal 
geometries, the Network Build Error Table will not be updated. Once you have fixed the geometry of 
the features reported in this table, it is no longer needed and can be deleted using ArcCatalog. 

There are a number of tools and commands in ArcMap to help you identify and repair network features 
with illegal geometries and with inconsistent network connectivity. 

6.6.2 About Identifying Network Build Errors 

When building a Geometric Network, the feature classes that are selected to participate in the network 
may contain features whose geometries are invalid within the context of a geometric network. These 
geometries include:  

 Features that have empty geometry  

 Edge features that contain multiple parts  

 Edge features that form a closed loop  

 Edge features that have zero length  

Features with invalid geometries are identified during the network building process and recorded in the 
network build errors table. The table is identified as the geometric network’s name appended with 
"_BUILDERR", for example, a network called "MyNetwork" will have a network build errors table called 
"MyNetwork _BUILDERR". The table is located at the workspace level and lists the Object ID, Class ID 
and Errortype for each error. The Errortype value corresponds to the esriNetworkErrorType enumeration, 
which lists the possible reason why a feature’s geometry is invalid with a geometric network. At the end of 
the geometric network build process, a summary of the errors listed in the table is displayed in a dialog 
box. (Figure 20) 

The Network Build Error Table is a user-managed table. As such, it does not get updated when the 
features listed within are edited. It is up to the end user to update the table’s contents as soon as possible 
after creation so that the table will correctly reflect the state of the features. The table is used by the 
Network Build Errors command within ArcMap to identify the features with invalid geometries. The 
methodology for repairing a network build error is dependent on the type of invalid geometry. 

6.6.3 How To Identify Network Build Errors (ArcInfo and ArcEditor only) 

1. In ArcMap, click View, point to Toolbars, and click Geometric Network Editing. The Geometric 
Network Editing toolbar is added to ArcMap. 

2. Add your network feature classes to ArcMap. 

3. On the Network toolbar, click Edit, then click Start Editing. 

4. In the ArcMap table of contents, select a layer that participates in the geometric network. 

5. Click the Build Errors command. 

6. A dialog box indicating the number of errors is displayed, and the features with illegal geometries 
are selected. 

Tips 
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If you built your geometric network in an ArcSDE geodatabase, you will need to register the data as 
versioned before you can start editing. 

If the number of errors indicated by the Network Build Errors dialog box does not match the number of 
selected features, you may have illegal features with empty geometry or zero length. Open the attribute 
editor to identify the illegal features according to feature class. 

6.7 Set Flow by Digitized Direction 

At this point the Geometric Network exists and can be viewed in ArcCatalog (Figure 22). However, to have 
it fully functional in ArcMap, allowing complete tracing operations on the network, Flow Direction must 
first be set. This can be done quickly, knowing that NHN features are generally digitized in a downstream 
direction, in particular the Network Linear Flow feature (especially with the "Primary" Level Priority 
attribute value), and using an ArcMap tool called the "Set Flow by Digitized Direction". 

The Set Flow by Digitized Direction command illustrates how to create a custom flow direction solver for 
utility networks. This command sets the flow direction for each edge feature in the network along the 
direction in which the feature was digitized. 

 

Products: ArcEditor: VB6 

Platforms: Windows  

Requires: A geometric network; an edit session. 

Minimum ArcGIS Release: 9.0 

For more information on the "Set Flow by Digitized Direction" tool from the ESRI Developer Network 
(EDN), you may refer to the following links: 

 http://edndoc.esri.com/arcobjects/9.2/CPP_VB6_VBA_VCPP_Doc/COM_Samples_Docs/Network/
Utility_Network_Analysis/Flow_Direction/Flow_by_Digitized_Direction/53e1fbe9-af49-4941-8d9e-
322c51d3c63c.htm  (to download the Set Flow by Digitized Direction tool and documentation) 

 http://edn.esri.com/index.cfm?fa=docLibrary.gateway  (to access the EDN Search Engine) 

 http://edn.esri.com/  (to access the ESRI Developer Network (EDN) home page) 

6.7.1 How to Use the Set Flow by Digitized Direction Tool 

1. Start ArcMap and add a geometric network (refer to section on "Creating a Geometric Network in 
ArcCatalog"). Add the Utility Network Analyst toolbar. 

2. Browse and select the MyFlowDirectionSolver.dll using the 'Add From File' button on the 
customization dialog. 

3. From the 'Developer Samples' commands category, add the 'Set Flow by Digitized Direction' 
command to the Utility Network Analyst toolbar. 

4. Add the Editor toolbar, and start editing. 

5. Click the command to set the flow according to the digitized direction of the features. 

In more details, the previous steps can be described as follows: 

1. Download the tool: Download the "Set Flow by Digitized Direction" tool and documentation 
archive from the link provided above. Make sure the version you download is compatible with your 
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ArcMap software version. The downloaded file should look something like "53e1fbe9-af49-4941-
8d9e-322c51d3c63cVisual_Basic.zip". This compressed file should be downloaded/copied where 
it is possible to uncompress it. 

2. Uncompress the ZIP file: Go to the folder where the newly downloaded compressed file is 
located (re: previous step) and uncompress it. This can be done using a zip file 
compression/decompression software such as Winzip (www.winzip.com), PKZIP 
(www.pkzip.com), etc. 

3. Add the "Utility Network Analyst" toolbar to ArcMap: Start ArcMap and add the "Utility 
Network Analyst" toolbar by selecting the View Menu -> Select Toolbars -> Select/check mark the 
"Utility Network Analyst" toolbar. The toolbar is now added to ArcMap (Figure 23). 

 

 

Set Flow by 
Digitized 

Direction Tool 

Figure 23 

4. Add the "Set Flow by Digitized Direction" tool to ArcMap's "Utility Network Analyst" toolbar: In 
ArcMap select the View Menu -> Select Toolbars -> Select "Customize". In the Customize window 
that pops up, select the Commands tab, then under Categories select "Utility Network Analyst" 
and finally click on the "Add from file…" button. In the Open window that pops up, navigate to the 
directory where the "Set Flow by Digitized Direction" ZIP archive was decompressed and then 
find, select and open the "MyFlowDirectionSolver.dll" file (Figure 24). In the "Added Objects…" 
window that pops up, make sure the "clsFDSolver" entry appears in the box and then click the OK 
button (Figure 25). The "MyFlowDirectionSolver.dll" has now been registered. To use the tool 
however, it must appear in the "Utility Network Analyst" toolbar. To do so, select the View Menu -> 
Select Toolbars -> Select "Customize". In the Customize window that pops up, select the 
"Commands" tab and use the "Categories" or left panel scroll to go to "Developer Samples" and 
click on it. Then select (one click) the "Set Flow by Digitized Direction" entry in the "Commands" or 
right panel. Drag & drop it to the "Utility Network Analyst" toolbar: To do so, click it again and hold 
down while dragging the icon to the "Utility Network Analyst" toolbar now added to the ArcMap 
environment. Place it where it is best for you. Once the icon is added to the "Utility Network 
Analyst" toolbar, click the "Close" button to close the Customize window. Note: The "Set Flow by 
Digitized Direction" icon looks exactly the same as the "Set Flow Direction" icon already 
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present on the "Utility Network Analyst" toolbar (Figure 23). The Set Flow by Digitized 
Direction" tool is now ready to use. 

 

Figure 24 

 

Figure 25 

5. Use the "Set Flow by Digitized Direction" tool to set flow in the Geometric Network: The tool 
requires that the network be in edit mode before it will work. On ArcMap's Editor toolbar click the 
Editor button -> Select "Start Editing". Make sure the right Geometric Network 
(FeatureDataset1_Net in this case) appears in the dropdown Network box of the "Utility Network 
Analyst" toolbar, and then click the "Set Flow by Digitized Direction" icon on the same "Utility 
Network Analyst" toolbar. [Remember this icon looks exactly the same as the "Set Flow Direction" 
icon. Make sure to use the right one. Just putting the mouse pointer over an icon will cause its 
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name to be displayed, which can be helpful in such case.] This operation will take some time 
depending on network size. Once completed, the Geometric Network is now oriented 
downstream, since the "Set Flow by Digitized Direction" processing was performed on a 
Geometric Network built from NHN data, which are normally digitized downstream. Now, on 
ArcMap's Editor toolbar click the Editor button -> Select "Save Edits". Then, still on the Editor 
toolbar, click the Editor button -> Select "Stop Editing". This terminates the editing session. The 
Geometric Network can now be tested to ensure it is OK and that it can be used. 

6. Use the "Utility Network Analyst" toolbar tools (Figure 23) to test the Geometric Network and 
ensure it is OK. For example, the "Flow" dropdown menu can be used to symbolized flow direction 
on network edges and discriminate between Determinate, Indeterminate and Uninitialized flows 
(Figure 26). Flow display properties can be modified directly by double-clicking the symbol under 
the "Arrow Symbol" tab of the "Flow Display Properties" window from the "Flow" dropdown menu. 
Trace functions from the "Trace Task" dropdown menu also can be used to test the network, in 
particular the Trace Upstream and Trace Downstream functions. Some areas may show up as not 
being connected, but they may in fact be internal drainages and have a different sink. All those 
isolated networks must be carefully looked at to make sure they are legitimate or not. [Note that in 
NHN-CL1 and CL2 data, some geometrical discontinuities may exist and affect Network Linear 
Features, which may cause the Geometric Network to be interrupted.] Also explore the analysis 
options from the "Analysis" dropdown menu and use some to test the Geometric Network further. 
The ultimate goal here is to make sure the Geometric Network is consistent and ready to use. See 
next section for more information on using the Geometric Network. 

 

Figure 26 
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7 USING THE GEOMETRIC NETWORK IN ARCMAP 

An ArcGIS Geometric Network has previously been created using NHN data. It is now time to use and 
exploit this network using the analysis options offered by ArcMap's Utility Network Analyst toolbar. 

7.1 About Tracing on Networks 

Network analysis involves tracing. The term tracing is used here to describe building a set of network 
elements according to some procedure. You can think of tracing as placing a transparency on top of a 
map of your network and tracing all the network elements that you want to include in your result onto the 
transparency. When working with networks, tracing involves connectivity. A network element can only be 
included in a trace result if it is in some way connected to other elements in the trace result. The trace 
result is the set of network features that is found by the trace operation. For example, suppose you want 
to find all of the features upstream of a particular point in a river network. Using a transparency placed 
over the map of the river network, you could trace over all of the branches of the river that were upstream 
of that point. What is drawn on the transparency after this would be your desired result. Similarly, when 
you perform a trace operation in ArcMap, your result is a set of the network elements included in the trace. 
In ArcMap, your trace results can either be drawings on top of your map or a selection. 

7.1.1 Flags and Barriers 

In ArcMap, flags define the starting points for traces. For example, if you are performing an upstream 
trace, you use a flag to specify where the upstream trace will begin. Flags can be placed anywhere along 
edges or on junctions. When performing the trace operation, ArcMap uses the underlying edge or junction 
feature as the starting point. Network elements connected to these edges or junctions are considered for 
inclusion in the trace result. Barriers define places in the network past which traces cannot continue. If 
you are only interested in tracing on a particular part of your network, you can use barriers to isolate that 
part of the network. Like flags, barriers can be placed anywhere along edges or on junctions. When 
performing trace operations, ArcMap treats the underlying network features as if they are disabled, thus 
preventing the trace from continuing beyond these features. 

7.1.2 Traced Features Vs Features Stopping the Trace 

When tracing using the Find Connected, Trace Downstream, or Trace Upstream trace tasks, you can 
return either the features that are traced or the features that stop the trace. Features that are traced are 
those that are actually traced over by the operation, while features that stop the trace are those past which 
the trace cannot continue. Features that stop the trace include the following: 

 Disabled features  

 Features on which barriers are placed  

 Traced features that are only connected to one other feature (dead ends)  

 Features that have been filtered out with a weight filter  

7.1.3 Using Selections to Modify Trace Tasks 

When tracing, ArcMap lets you use selections in three main ways. 

 Using the Analysis Options dialog box, you can specify whether the trace operation is performed 
on all features in the network, on the selected features only, or on the unselected features only. 
Tracing on just the selected features means that unselected features act as barriers, while tracing 
on just the unselected features means that selected features act as barriers. By using selections 
in this manner, you could perform a trace operation to produce a set of barriers for a subsequent 
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operation, or you could build a selection query to produce a set of network features upon which to 
perform a trace operation. 

 You can specify which layers are selected when performing a trace operation. From the Selection 
menu in ArcMap, you can specify which layers can and cannot be selected. When ArcMap returns 
the results of a trace operation as a selection set, the settings you specify in the Selection menu 
are used to determine which features should be included in the selection set returned by the trace. 

 You can use the interactive selection method—set through the Selection menu—to specify the 
behavior of the resulting selection set. You can create a new selection, add the results of your 
trace operation to the current selection, select the results of your trace operation from the current 
selection, or remove the results of your trace operation from the current selection. 

By using the power of selections in ArcMap, you can use the simple trace tasks included with ArcMap to 
perform compound and complex trace operations. 

7.1.4 Putting It All Together 

In summary, when constructing traces to perform on your network, you can: 

 Return the trace results as a selection set. 

 Disable individual features or entire feature layers. 

 Place barriers on edges or junctions. 

 Include the traced features or the features stopping the trace. 

 Trace only on selected or unselected features. 

 Specify which layers to include in the results. 

 Use different selection methods. 

All of these concepts can be used simultaneously when creating a trace result. Combining these concepts 
in trace operations allows you to execute very powerful traces on your network. 
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7.2 Tracing Operations 

 

Figure 27 

With ArcMap's Utility Network Analyst toolbar, you can find:  

 All network elements that lie upstream of a given point in your network (trace upstream). 

 All network elements that lie downstream of a given point in your network (trace downstream). 

 The total cost of all network elements that lie upstream of a given point in your network (upstream 
accumulation). 

 An upstream path from a point in your network (find path upstream). 

 The common features that are upstream of a set of points in your network (find common 
ancestors). 

 All of the features that are connected to a given point through your network (find connected). 

 All of the features that are not connected to a given point through your network (find 
disconnected). 

 Loops that can result in multiple paths between points in a network (find loops). 

 A path between two points in the network. The path found can be just one of a number of paths 
between these two points—depending on whether or not your network contains loops (find path). 

7.2.1 Adding Flags and Barriers 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click the button representing the flag or barrier element that you want to add to the network. 

2. Point to the edge or junction feature to which you want to add the flag or barrier. 

3. Click to add the flag or barrier. 

7.2.2 Tracing Upstream 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point from which you want to trace upstream. 
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3. Click the Trace Task dropdown arrow and click Trace Upstream. 

4. Click the Solve button. 

All of the features upstream of your flags are displayed. (Figure 28) 

 

Figure 28 

7.2.3 Tracing Downstream 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point from which you want to trace downstream. 

3. Click the Trace Task dropdown arrow and click Trace Downstream. 

All of the features downstream of your flags are displayed. (Figure 29) 
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Figure 29 

7.2.4 Finding the Upstream Accumulation 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point from which you want to find the upstream 
accumulation. 

3. Click Analysis and click Options. (NOTE: Steps 3 to 8 are not required for NHN Geometric 
Network) 

4. Click the Weights tab. 

5. Click the Junction weights dropdown arrow and click the name of the weight you want to use for 
junctions. 

6. Click the From-to edge weight dropdown arrow and click the name of the weight you want to use 
for tracing edges along the digitized direction. 

7. Click the To-from edge weight dropdown arrow and click the name of the weight you want to use 
for tracing edges against the digitized direction. 

8. Click OK. 

9. Click the Trace Task dropdown arrow and click Find Upstream Accumulation. 
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10. Click the Solve button. 

All of the features upstream of your flags are displayed, and the total cost of these features is 
reported in the status bar. 

 

Tip 
 By default, the Find Upstream Accumulation trace task does not use weights. If you do not use 

weights, the cost reported is the number of edge elements in the result.  

7.2.5 Finding an Upstream Path to the Source 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point for which you want to find an upstream path to the 
source. 

3. Click the Trace Task dropdown arrow and click Find Path Upstream. 

4. Click the Solve button. 

An upstream path from the flag to the source is displayed for each of your flags. 

 

Tip 
 By default, the Find Path Upstream trace task does not use weights. If you use weights, the 

upstream path found to the source is the shortest path based on the weights you specify. To 
specify weights, follow steps 3 through 7 for finding the upstream accumulation (above).  

7.2.6 Finding Common Ancestors 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point for which you want to find common ancestors. 

3. Click the Trace Task dropdown arrow and click Find Common Ancestors. 

4. Click the Solve button. 

The features that are upstream of all of your flags are displayed. 

7.2.7 Finding Connected Features 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point for which you want to find the connected features. 

3. Click the Trace Task dropdown arrow and click Find Connected. 

4. Click the Solve button. 
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The features that are connected to the features on which you placed your flags are displayed. 

Tip 
 The Find Disconnected trace task always returns the features that the Find Connected trace task 

does not. The results of one of these trace tasks are often easier to view and analyze than the 
results of the other. For example, suppose you have a mostly connected network and you would 
like to check to make sure all of your network features are connected to each other. Performing a 
Find Disconnected trace task and checking to see if no features are returned is easier than 
performing a Find Connected trace task and making sure all of your features are returned. 

7.2.8 Finding Disconnected Features 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags at each point for which you want to find the disconnected features. 

3. Click the Trace Task dropdown arrow and click Find Disconnected. 

4. Click the Solve button. 

The features that are not connected to the features on which you placed your flags are displayed. 

7.2.9 Finding a Path 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button. 

2. Click on the map to place flags on the features among which you want to find a path. 

3. Click the Trace Task dropdown arrow and click Find Path. 

4. Click the Solve button. 

A path between the features on which you placed flags is displayed. (Figure 29) 

 

Tips 
 When you use the Find Path trace task, the flags you place on the network must be either all 

edge flags or all junction flags. You cannot find a path among a mixture of edge and junction 
flags.  

 By default, the Find Path trace task does not use weights. If you do not use weights, the path 
found is the shortest path based on the number of edge elements in the path.  
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Figure 30 

7.2.10 Finding Loops 

1. Click the Flag and Barrier tool palette dropdown arrow on the Utility Network Analyst toolbar and 
click a flag tool button  

2. Click on the map to place at least one flag on each connected component in which you want to 
find the loops. 

3. Click the Trace Task dropdown arrow and click Find Loops. 

4. Click the Solve button. 

For each connected component on which you placed a flag, the features that loop back on 
themselves (that is, can't be reached from more than one direction) are displayed. 

7.2.11 Other Tracing Operations… 

Other tracing operations can be performed using the basic Trace Task options from the ArcMap Utility 
Network Analyst toolbar. Queries like "Finding the shortest path", "Isolating a point on the network", 
"Finding Connected Features Using Weight Filters", "Finding an Upstream Path", etc. are described in 
the ArcGIS Desktop Help and should be referred to for more information. To access this information, 
go under ArcGIS Desktop Help's Index tab, type in the keyword "tracing" directly in the upper left 
corner text box and then double-click the "operations" entry on the dropdown search results' panel 
below. All documented Tracing Operations will show in the right panel, including those previously 
described here. 
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8 GLOSSARY 

ArcCatalog 

ArcGIS Desktop Application that provides data access and spatial data management tools, including the 
reading and creation of metadata. 

ArcGIS 

ESRI'sTM Geographic Information System (GIS) software product. 

ArcMap 

ArcGIS Desktop Application that lets you view, create, and query maps, as well as edit data. 

ArcSDE 

Advanced spatial data server for managing geographic information in numerous relational database 
management systems (RDBMS). ArcSDE is the data server between ArcGIS and relational databases. It 
is used to enable geodatabases to be shared by many users across any network and to scale in size to 
any level necessary. 

attribute 

Information about a geographic feature in a GIS, usually stored in a table and linked to the feature by a 
unique identifier. For example, attributes of a river might include its name, length, and average depth. 

attribute domain 

In a geodatabase, a mechanism for enforcing data integrity. Attribute domains define what values are 
allowed in a field in a feature class or nonspatial attribute table. If the features or nonspatial objects have 
been grouped into subtypes, different attribute domains can be assigned to each of the subtypes. 

attribute table 

A database or tabular file containing information about a set of geographic features, usually arranged so 
that each row represents a feature and each column represents one feature attribute. In raster datasets, 
each row of an attribute table corresponds to a certain region of cells having the same value. In a GIS, 
attribute tables are often joined or related to spatial data layers, and the attribute values they contain can 
be used to find, query, and symbolize features or raster cells. 

barrier 

A line feature used to keep certain points from being used in the calculation of new values when 
interpolating a grid or creating a TIN. The line can represent a cliff, ridge, or some other interruption in the 
landscape. Only the sample points on the same side of the barrier as the current processing cell will be 
considered. 

behavior 

The way in which an object in a geodatabase functions or operates. Behavior rules define how 
geodatabase objects can be edited and drawn. Defined behaviors include, but are not limited to, validation 
rules, subtypes, default values, and relationships. 

cardinality 
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A relationship between objects in a database, which describes the number of objects of one type that are 
associated with objects of another type. A relationship can have a cardinality of one-to-one, one-to-many, 
many-to-one, or many-to-many. 

connectivity 

In a geodatabase, the state of edges and junctions in a logical network that controls flow, tracing, and 
pathfinding. 

coordinate system 

A fixed reference framework superimposed onto the surface of an area to designate the position of a point 
within it; a reference system consisting of a set of points, lines, and/or surfaces; and a set of rules, used to 
define the positions of points in space in either two or three dimensions. The Cartesian coordinate system 
and the geographic coordinate system used on the earth's surface are common examples of coordinate 
systems. 

disabled feature 

A network object or shape representing a geographic object through which flow is impossible. 

edge element 

A line connecting nodes in the network through which a commodity, such as information, water, or 
electricity, presumably flows. 

enabled feature 

In geodatabases, a network feature that allows flow to pass through it. 

ESRITM 

Environmental Systems Research Institute ( http://esri.com/ ). 

feature class 

A collection of geographic features with the same geometry type (such as point, line, or polygon), the 
same attributes, and the same spatial reference. Feature classes can stand alone within a geodatabase or 
be contained within shapefiles, coverages, or other feature datasets. Feature classes allow homogeneous 
features to be grouped into a single unit for data storage purposes. For example, highways, primary 
roads, and secondary roads can be grouped into a line feature class named "roads". In a geodatabase, 
feature classes can also store annotation and dimensions. 

feature dataset 

A collection of feature classes stored together that share the same spatial reference; that is, they have the 
same coordinate system, and their features fall within a common geographic area. Feature classes with 
different geometry types may be stored in a feature dataset. 

field 

A column in a table that stores the values for a single attribute. 

flag 

In ArcMap, an object that is placed on a network to specify the starting point for a trace task. 

foreign key 
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A column or combination of columns in one table whose values match the primary key in another table. A 
value in the foreign key can only exist if there is a corresponding value in the primary key, unless the 
value is NULL. Foreign key primary key relationships define a relational join. 

GeoBase 

GeoBase is a federal, provincial and territorial government initiative that is overseen by the Canadian 
Council on Geomatics (CCOG). It is undertaken to ensure the provision of, and access to, a common, up-
to-date and maintained base of quality geospatial data for all of Canada. Through the GeoBase portal 
(www.geobase.ca), users with an interest in the field of geomatics have access to quality geospatial 
information at no cost and with unrestricted use. 

geodatabase 

An object-oriented data model introduced by ESRI that represents geographic features and attributes as 
objects and the relationships between objects, but is hosted inside a relational database management 
system. A geodatabase can store objects, such as feature classes, feature datasets, nonspatial tables, 
and relationship classes. 

geometric network 

Topologically connected edge and junction features that represent a linear network, such as a road, utility, 
or hydrologic system. 

GIS 

Geographic Information System. 

Hydro Junction (HJ) 

NHN feature, always positionned at each end of a Network Linear Element, used to determine adjoining linear 
features to this last. 

junction element 

In a linear network, a network feature that occurs at the intersection of two or more edges or at the 
endpoint of an edge that allows the transfer of flow between edges. 

logical network 

An abstract representation of a network. A logical network consists of edge, junction, and turn elements 
and the connectivity between them. It does not contain information about the geometry or location of its 
elements. 

network 

A set of edge, junction, and turn elements and the connectivity between them; also known as a logical 
network. In other words, an interconnected set of lines representing possible paths from one location to 
another. A city streets layer is an example of a network. 

Network Linear Flow (NLF) 

NHN feature that traces the movement of water in a one-dimension virtual water flow route. 

NHN 

The National Hydro Network (NHN) is a geospatial vector data product that forms the hydrographic layer 
of the GeoBase (http://www.geobase.ca/geobase/en/data/nhn/index.html) describing Canada's inland 
surface waters. 
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NHN-CL1 

The "National Hydro Network – Completeness Level One" is the first data completeness level set by the 
NHN Implementation Strategy. For more information, refer to the NHN Data section on the GeoBase 
portal at http://www.geobase.ca/geobase/en/data/nhn/completeness.html . 

NHN-CL2 

The "National Hydro Network – Completeness Level Two" is the second data completeness level set by 
the NHN Implementation Strategy. For more information, refer to the NHN Data section on the GeoBase 
portal at http://www.geobase.ca/geobase/en/data/nhn/completeness.html . 

NHN-CL3 

The "National Hydro Network – Completeness Level Three" is the third data completeness level set by the 
NHN Implementation Strategy. For more information, refer to the NHN Data section on the GeoBase 
portal at http://www.geobase.ca/geobase/en/data/nhn/completeness.html . 

NHN-CL4 

The "National Hydro Network – Completeness Level Four" is the fourth and last data completeness level 
set by the NHN Implementation Strategy. For more information, refer to the NHN Data section on the 
GeoBase portal at http://www.geobase.ca/geobase/en/data/nhn/completeness.html . 

personal geodatabase (PGD) 

A geodatabase that stores data in a single-user relational database management system (RDBMS). A 
personal geodatabase can be read simultaneously by several users, but only one user at a time can write 
data into it. 

relationship 

An association or link between two objects in a geodatabase. Relationships can exist between spatial 
objects (features in feature classes), between nonspatial objects (rows in a table), or between spatial and 
nonspatial objects. 

relationship class 

An item in the geodatabase that stores information about a relationship. A relationship class is visible as 
an item in the ArcCatalog tree or contents view. 

simple feature 

A point, line, or polygon that is not part of a geometric network and is not an annotation feature, dimension 
feature, or custom object. 

sink 

A junction feature that pulls flow toward itself from the edges in the network. For example, in a river 
network, the mouth of the river can be modeled as a sink, since gravity drives all water toward it. 

snapping environment 

Settings in the ArcMap Snapping Environment window and Editing Options dialog box that define the 
conditions in which snapping will occur. These settings include snapping tolerance, snapping properties, 
and snapping priority. 

source 
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A junction feature that pushes flow away from itself through the edges of the network. For example, in a 
water distribution network, pump stations can be modeled as sources, since they drive the water through 
the pipes away from the pump stations. 

spatial reference 

The coordinate system used to store a spatial dataset. For feature classes and feature datasets within a 
geodatabase, the spatial reference also includes the spatial domain. 

subtype 

In geodatabases, a subset of features in a feature class or objects in a table that share the same 
attributes. For example, the streets in a streets feature class could be categorized into three subtypes: 
local streets, collector streets, and arterial streets. Creating subtypes can be more efficient than creating 
many feature classes or tables in a geodatabase. For example, a geodatabase with a dozen feature 
classes that have subtypes will perform better than a geodatabase with a hundred feature classes. 
Subtypes also make editing data faster and more accurate because default attribute values and domains 
can be set up. For example, a Local Street subtype could be created and defined so that whenever this 
type of street is added to the feature class, its speed limit attribute is automatically set to 35 miles per 
hour. 

topological association 

The spatial relationship between features that share geometry such as boundaries and vertices. When a 
boundary or vertex shared by two or more features is edited using the topology tools in ArcMap, the shape 
of each of those features is updated. 

topology 

In geodatabases, a set of governing rules applied to feature classes that explicitly define the spatial 
relationships that must exist between feature data. 

tracing 

The process of building a set of network features based on some procedure. 
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